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1 Introduction
The topics discussed in this guide are:

• How to Learn COSMOSM. This section provides new users with brief 
instructions on how to learn COSMOSM and how to use the electronic 
documentation.

• Installing COSMOSM. This chapter contains installation information and tips.
• What’s New in COSMOSM 2.95. This chapter lists new features and 

enhancements.
• COSMOS License Administrator. This chapter contains detailed information 

about using COSMOS License Administrator to administer stand-alone and 
network licenses. 

• Detailed Examples. This chapter contains step-by-step tutorial to help new users 
get started.

COSMOSM Distribution Material

Depending on the analysis bundles you acquire, you will receive COSMOSM on 
one of the following CDs:

• COSMOSWorks CD
• COSMOS Products CD
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Each CD includes the following COSMOSM software and utilities:

COSMOSM full version and all analysis modules

Several versions of GEOSTAR supporting different numbers of nodes/elements are 
automatically installed. The databases created by these versions are not compatible 
with one another. You will not be able to use one of them to open a database that 
has been created by the other. The session (.ses) and the (.gfm) files are, however, 
compatible and can be used to reconstruct the model created by one version in 
another. All analysis modules are included on the CD.

COSMOSM 2.95 Explorer

The Explorer version is limited to 5,000 nodes/elements. The installation procedure 
installs the 64,000 node/element version but the Explorer license limits the number 
of nodes/elements to 5,000.

COSMOSM Evaluation Version

The Evaluation version is limited to 50 nodes/elements. This version is provided 
free of charge for evaluation purposes only. It is not intended for any other use. No 
security string is required for this version. 

Electronic Documentation

The complete set of electronic manuals for COSMOSM 2.95 release are included 
on the CD in PDF (Portable Document File) format. The Adobe Acrobat Reader 
version 4.0 or later is required. You can download the latest version from 
www.adobe.com. Adobe provides the Acrobat Reader free of charge.

Verification Problems

COSMOSM results are verified against many problems with analytical solutions. 
The description of each verification problem is provided in the manual associated 
with the analysis type. The input files for all verification problems are placed in a 
sub-directory called vprobs in the COSMOSM installation directory. A sub-
directory is allocated for each analysis module. 
COSMOSM Getting Started
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Database Utility and Translators

The Database Utility is a library of sub-programs written in the C language that 
enables you to read from and write to COSMOSM 2.9 database files. You do not 
need the database utility for regular use of COSMOSM. You only need it to create a 
communication channel between your own programs and the database of 
COSMOSM. The Database Utility and all translators are included with this release 
and can be used with the full-fledged and the Explorer versions.

A detailed list of the enhancements introduced in the various modules of 
COSMOSM 2.9 is presented in the What’s New in COSMOSM 2.9 chapter.

GEOSTAR Manager Utility

The GEOSTAR Manager is a utility program meant to ease the use of different 
versions of GEOSTAR. In particular, the GEOSTAR Manager lets you choose 
which version of GEOSTAR to run. It also lets you choose a default start-in 
directory and informs you of the limitations of each version. To access the 
GEOSTAR Manager utility, click Start, Programs, COSMOS 2005 Applications, 
GEOSTAR Manager.
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2 How to Learn COSMOSM
Introduction

COSMOSM consists of the pre- and post-processor GEOSTAR and many analysis 
modules in addition to material libraries, import/export translators, and other tools. 
You can install COSMOSM from the COSMOS Products CD, COSMOSWorks 
CD. COSMOSWorks and COSMOSDesignSTAR are two other products offered by 
Structural Research & Analysis Corp. The installation of these products offers an 
option to install COSMOSM.

Refer to www.cosmosm.com for more information on products of Structural 
Research and Analysis Corporation.

How to Learn GEOSTAR

The online help of GEOSTAR provides a tutorial and a How To section that are 
very useful. The How To section shows you how to run each type of analysis. The 
online help contains the full description of all finite elements with graphical 
illustrations. This manual provides two examples in the Getting Started chapter. 
The first example guides you step-by-step through building a simple geometry, 
assigning material, choosing the element type, meshing, defining loads and 
boundary conditions, running stress analysis, and visualizing the results. The 
COSMOSM Getting Started 2-1
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second example shows you how to import a solid model from a CAD system and 
analyze it in GEOSTAR. Most of the steps are typical for other types of analyses. 

After that, read the first three chapters in the User’s Guide. Chapter 4 describes the 
types of finite elements available in COSMOSM. The other chapters and 
appendices in the User’s Guide give you more information and examples. The 
COSMOSM Command Reference manual is basically similar to the on-line help 
and provides detailed information for all the commands in GEOSTAR.

The Basic System manual provides background and detailed information about 
linear stress analysis, frequency, and buckling. The Advanced Modules manual 
provides background and detailed information about advanced modules.

Verification problems are provided for every type of analysis. The files of 
verification problems are included in the vprobs folder in the COSMOSM 
installation directory. A verification problem can be loaded into GEOSTAR by 
creating a new problem with any name and then loading the corresponding file 
using the File (File, Load) command.    

How to Learn About Stress, Frequency, and 
Buckling Analyses

Refer to the COSMOSM Basic System manual. This manual gives you detailed 
information and examples about using GEOSTAR to run stress, frequency, and 
buckling analyses using the conventional solvers (STAR, DSTAR, and STRES). 
Brief theoretical background is also provided. The online help also provides a 
tutorial for static and frequency analyses.

COSMOSFFE Static and COSMOSFFE Frequency can be used to solve stress and 
frequency problems. Refer to the COSMOSFFE User’s Guide for information and 
examples on using COSMOSFFE Static to solve stress problems and 
COSMOSFFE Frequency to calculate resonant (natural) frequencies. 

How to Learn About Other Types of Analysis

The online help in GEOSTAR gives you procedures to run various types of 
analyses. The COSMOSM Advanced Modules manual includes detailed 
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information about using GEOSTAR to run dynamic response problems (ASTAR), 
nonlinear structural problems (NSTAR), heat transfer problems (HSTAR), fatigue 
problems (FSTAR), low-frequency electromagnetic problems (ESTAR), and 
optimization problems (OPTSTAR). 

To use COSMOSFFE Thermal, refer to the COSMOSFFE Modules manual.

To learn about the electromagnetic high-frequency solvers, refer to the 
COSMOSHFS manuals. There are 3 manual for COSMOSHFS, namely: 
COSMOSHFS 2D, COSMOSHFS 3D, and COSMOSCAVITY.

Accessing the Electronic Manuals

Complete COSMOSM 2.85 electronic documentation is available as PDF files on 
the CD. PDF (Portable Document Format) files are easily viewed, searched, and 
printed. 

✍ The Adobe Acrobat Reader, version 4.0 or later, is required to view these 
files. You can download the most recent reader from www.adobe.com. Adobe 
provides the Acrobat Reader free of charge.

The installation program automatically creates an icon called Online Manuals in the 
COSMOSM Program Group. If you have not installed the documentation, the 
manuals will be accessed from the CD. 

To install the electronic manuals on your hard disk:

1. Activate the check box for installing the COSMOSM 2.85 documentation 
during the installation process.

2. Follow on-screen instructions. The program will copy the documents to the 
specified location on your hard disk and will change the properties of the On-
line Manuals icon to point to the new location.
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To start the electronic documentation:

1. Click Start, Programs, COSMOS Applications, COSMOSM Documentation, 
or double-click the CMManuals.pdf file in the DOCS directory of the 
COSMOSM installation. A window offering several options opens. 

2. Click the Help button for a quick help on how to use electronic documentation.

3. Click the Global Search button if you want to search all COSMOSM manuals.

4. Click the Technical Support button for information to access technical support.

5. Click the Copyright button for copyright information.

6. To open a manual, click its name.

7. Once inside the Acrobat Reader, a table of contents will be displayed in the left 
pane. Click the desired section to display it. Scroll, search, zoom-in, zoom-out, 
or print as needed. The buttons on each page give quick access to searching, 
printing, and navigation.

8. You can navigate easily throughout the book by clicking the desired topic in the 
left pane.
COSMOSM Getting Started



3 Installing COSMOSM
Introduction

This section provides you with general information on installing and operating the 
COSMOSM software.The complete documentation of the program is also included 
on the CD-ROM and can be easily browsed, searched, and printed.

A setup program called setup.exe is provided to install the program on your 
computer system. 

✍ Administrator privileges are required to install COSMOSM on Windows NT, 
XP, and 2000. The following error messages will be issued by the system if 
you try to install the program on Windows NT or Windows 2000 platforms as 
a user without administrator privileges:
Failed to set COSMOSM
Failed to set Path
Error updating the registry

The dynamic setup procedure installs the program and configures the license. The 
dialog boxes are self-explanatory and provide plenty of information. A separate 
program called COSMOS License Administrator is provided for convenience to 
let you quickly administrate your license and monitor its usage.
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Before installing COSMOSM, please note that:

1. You must have administrator privileges to run the setup procedure properly.

2. If you are installing COSMOSM from COSMOSWorks or COSMOS Products 
CD, make sure to select COSMOSM in the window that lists the products to 
install.

3. Make sure that your system satisfies the minimum requirements.

System Requirements

1. Pentium- or AMD-based computers with Windows NT 4.0 (or higher), 
Windows 2000, 98, 95, ME, or XP operating systems.

2. Minimum of 64 MB of RAM (256 MB or higher is recommended). A SWAP 
space of at least 160 MB should also be specified.

3. 282 MB of free disk space is needed to install the program and documentation. 
About 1 GB or more additional disk space is recommended for running the 
program.

4. CD-ROM drive.

5. Video display and adapter.

6. Parallel port (required for Hardware Security key)

7. Network card (required for FLEXlm network security option) and TCP/IP and 
SPX/IPX network software components.

8. Mouse or other pointing device.

9. Plotters and Printers are optional.
COSMOSM Getting Started



Chapter 3   Installing COSMOSM
Outline of Installation Options

To install COSMOS products properly, you must determine whether your computer 
will work as a stand-alone or as part of a network. If you will be using 
COSMOSWorks on a client machine of a network system, program files can be 
installed on your local computer or they can be installed on the server. The 
following outline summarizes the setup options available when installing 
COSMOSM.

After installing program files, the installation procedure guides you step-by-step to 
configure your license. Here is an overview of the installation procedures.

✍ The COSMOS License Administrator lets you check and administer all aspects 
of COSMOS Application licenses. Refer to the COSMOS License 
Administrator chapter for details. 

Stand-alone Installation

Program Files

Install the program from the CD. If the setup does not start automatically, double-
click the setup.exe file on the root folder of the CD. 

License Configuration

You should have received a security device (dongle or USB key) and a license file 
or just a license file. In both cases the license file name is license.dat.

✍ You must install the security device before configuring your license.

You can use the COSMOS License Administrator to check or reconfigure your 
license based on the license file. You will need to install the security device and 
point to the license file (license.dat) which is specific to your security device. If you 
do not have the file, the COSMOS License Administrator lets you request it 
through the Internet. 

✍ To start the COSMOS License Administrator, click Start, Programs, COSMOS 
Applications, License Administrator Tool. 
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If you have received a node-locked license (no security device), the license.dat file 
you have received must have your system ID encoded in it. If you do not have the 
file, the COSMOS License Administrator lets you request it through the Internet. 

Network Installation

File and License Server

1. Install the program and license file(s) on the Server machine.

2. On each Client machine, map the COSMOS directory on the Server and set the 
COSMOSM environment to point to the COSMOS folder on the server. You 
can set the COSMOS working directory to a local drive.

✍ You can also perform a stand-alone installation on the client machines and use 
the COSMOS License Administrator tool to configure the license by pointing to 
the license.dat file on the Server. 

License Server only

1. Copy the license file(s) on the Server machine. Do not install the program files 
on the Server.

2. Perform stand-alone installation on each Client machine.

3. Configure the license on each client machine by pointing to the license file(s) on 
the Server.

✍ You may not run COSMOSM on the Server in this case since it does not have 
access to program files.

You can use the COSMOS License Administrator to check or reconfigure, your 
license based on the license file. You will need to install the security device and 
point to the license file (license.dat) specific to your security device. If you do not 
have the file, the COSMOS License Administrator lets you request it through the 
Internet. 

✍ To start the COSMOS License Administrator, click Start, Programs, COSMOS 
Applications, License Administrator Tool. 
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If you have received a node-locked license (no security device), the license.dat file 
you have received must have your system ID encoded in it. If you do not have the 
file, the COSMOS License Administrator lets you request it through the Internet. 

If the installation program detects an existing installation, it will give the option to 
create a new installation folder or update the existing one. 

Starting the Installation

To install COSMOSM:

1. If you downloaded an executable from the web, start the installation procedure 
by double-clicking the file that you have downloaded.

2. If you have received a CD, insert the CD in the CD-ROM drive. The setup pro-
gram starts automatically. Read the Welcome message and click Next. The 
Software License Agreement window opens.

✍ If you have turned off the autorun feature or if the setup does not start 
automatically, go to your CD-ROM drive in Windows Explorer and double-
click autorun.exe file.

3. Read the agreement and click the Yes button if you agree to all terms and 
conditions. Otherwise click No to exit the installation program. If you select 
Yes, the COSMOS License Information window opens.

4. Follow on-screen instructions to copy program files and configure your license.

Installation Tips

1. It is recommended to close all windows and applications before starting the 
installation procedure.

2. When the installation has been completed, we recommend that you use the 
COSMOS License Administrator to verify your license. Refer to COSMOS 
License Administrator chapter for details.
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3. If the installation procedure detects a previous installation, it will offer you 
options to modify, repair, or remove the previous installation, in addition to an 
option to configure your license.

✍ If you choose to update an existing installation, the program gives you a chance 
to save the standard material library file since you might have customized it.

4. You need to configure the license before you will be able to run COSMOSM. 
You can point to a license file, type it (if you get it by fax), request a license 
through your Internet connection, or choose to configure your license later on. If 
you choose to type, make sure to type in the license as it appears on the 
document that you have received.

5. It is recommended to install all COSMOS products in the same directory.

6. The installation procedure asks for a folder where COSMOSM will store the 
results of FEA studies. Large files are needed to store results of large problems, 
so this folder should have plenty of disk space.
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4 What’s New in 
COSMOSM 2.95
This chapter lists the new features and enhancements in COSMOSM 2.95:

• STAR now gives a warning if the displacements become large. It offers you an 
option to assume large displacements instead of using the small displacement 
theory. 

• The A_STATIC command now allows you to specify large displacement 
solution. STAR runs a number of load steps automatically. You do not have any 
control on specifying how the load is incremented. . Unlike NSTAR, you can 
only view results associated with the full load. The A_LIST command lists 
whether small or large displacement solution is used. This option is available 
with the direct sparse and FFEPLUS solvers. It is not available with FFE.   

• A new material model for Nitinol is now supported by NSTAR. See online help 
for details.

• The material type of the EGROUP command for SOLID, TETRA4 and 
TETRA10 elements (Op 5) has been expanded to include 14=NIT for Nitinol 
Material Model.

• The MPROP command has been improved to help you define related material 
properties faster. For example, if you define SIGT_S1, the SIGT_F1 appears 
next by default in the dialog box.
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5 COSMOS License 
Administrator
Types of COSMOS Licenses

All licenses require a license.dat file. Structural Research and Analysis Corp. 
provides the following types of licenses for its COSMOS products:

Floating License

License authorized for use on a network. Any computer on the network can be set 
to use the floating license. At any time, the number of computers running a product 
may not exceed the authorized number of licenses. Only a license file is needed.

Node-locked License

License authorized for a specific computer. Only a license file is needed.

Hardware-based License

License authorized for one stand-alone computer at any time. A hardware security 
lock (dongle) and an associated license file are needed.
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Demo License

License authorized for a certain period of time. 

Features of the COSMOS License Administrator

In the process of administrating your COSMOS License, the COSMOS License 
Administrator helps you:

• Find out the host ID and name of your machine.
• Find out your hardware lock number.
• Request a license from SRAC web site.
• Install and start hardware lock drivers. You don’t need to launch separate 

license configuration program to install the drivers and in most case you 
don’t need to reboot your computer.

✍ You do not need to reboot if you are running Windows XP, NT, or 2000 NT. 
You need to reboot if you are running Windows 98 or ME. 
• If you point to a license file, COSMOS License Administrator will do all 

the necessary procedure to setup your license. 
• Gives a detailed list of all the available modules based on your license 

settings. For each authorized module, this list gives the information like 
license type, expiration date, if failed reason for failure etc.

• COSMOS licensing is based on FLEXlm technology. The FLEXlm license 
server needs to be installed on your system. COSMOS License 
Administrator let you quickly start, stop, restart, or remove the FLEXlm 
server. 

• For a client machine, you can point to a license file on a server machine. You 
do not need to setup the any system environment variables as required in 
earlier versions.
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FLEXlm Capabilities

COSMOS Licensing scheme is based on FLEXlm which has the following 
features.

• Support of redundant servers. With this option, you can setup one primary 
server and 2 secondary servers. If the primary server goes down, the 
secondary servers will resume its COSMOS licensing duties without any 
interruption.

• Client machines do not need to have read access to a license.dat file placed 
on the server. Instead you can set the client license to port@host. For 
example, if the FLEXlm license server runs on a machine called “Lion”, you 
can set your client machine to access license file from 7585@Lion instead of 
mapping and pointing to the license directory on the server machine.

✍ 7585 is the default port for COSMOS License Server.
• Procedure to setup node locked FLEXlm licenses have been simplified. If 

you have a node locked FLEXlm license, you do not need to start COSMOS 
license server. You simply need to copy the license.dat file to the 
“...\license” directory. During the installation, all you need to do is to point 
to the right license file. Everything else will be done automatically.

• The installation program gives an option to setup a FLEXlm options file.
• In addition to the old dongle, this version supports USB Port Sentinel key 

which connects to a USB port freeing up the parallel port from any possible 
conflict with other peripherals. 

✍ The USB port Sentinel keys work on Windows 98, Windows ME, Windows 
2000 and Windows XP (windows NT is not supported).

USB Port Security Device Parallel Port Dongle
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Status Tab

The Status page gives information about the current status of software- and 
hardware-based COSMOS licenses. If you have both license schemes installed, you 
will be able to run a product as long as it is authorized by one of them. COSMOS 
licenses are based on FLEXlm technology. If both license schemes failed, click the 
Configure License button to select a license file on your computer or set the port 
and host name of a license server.

Information Type

License Information
• Authorization: The Status column tells you whether the authorization check 

has Passed or Failed. The Remarks column tells you the reason of the 
authorization failure. 

• License File Used: The Remarks column lists the license file used. Use the 
Authorized Modules tab to select a different license file(s).

• License Type: The Status column lists the type of the detected license. A 
license file is needed in all cases. Refer to Types of COSMOS Licenses.
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Dongle Information
• Sentinel Driver Detected: The Sentinel driver should be installed and 

running for this type of license to work. The Status column tells you 
whether a license has been detected. The Remarks column lists the version 
of the detected driver, if any.

• Sentinel Driver Running: The Status column tells you whether the driver 
is running. 

• Sentinel Dongle Detected: The Status column tells you whether a dongle 
has been. The Remarks column lists the model and ID of the detected 
dongle, if any.

Maintenance Information
• Maintenance Number: The Status column lists whether a maintenance 

number has been detected. The Remarks column lists the detected 
maintenance number, if any.

• Maintenance Expiration Date: The Status column lists whether a 
maintenance expiration date has been detected. The Remarks column lists 
the expiration date.

• Customer Name: The Status column lists whether a customer name has 
been detected. The Remarks column lists the detected customer name, if 
any.

Refresh

The Refresh button updates the status screen based on the current settings. For 
example, click this button after installing a dongle or copying a license file.

Configure License

The Configure License button opens the Configure COSMOS License dialog box 
to let you configure your COSMOS license.
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Configure COSMOS License

The Configure COSMOS License dialog box lets you configure your COSMOS 
license. To open this dialog box, click the Status tab and then click the Configure 
License button.

Select COSMOS License File

Select this option and then click the Browse button to point to the license file. 
Although you can use this option to point to a license file on a server, it is 
recommended to use the other option, Set Port and Host of the License Server, 
in such a case so that the license will continue to work even if the location of the 
license file on the server changes. Based on the license file, the Administrator will 
figure out the type of the license. If it detects that a dongle is required with the 
license file, it will automatically install the required Sentinel drivers.

Set Port and Host of the License Server

Select this option if the license file is placed on a license server. You just specify the 
port number and the host name. Using this option ensures that the license will 
continue to work even if the location of the license on the server changes.

Port Number

The default number used by COSMOS License administrator is 7585. Check with 
your network administrator to get another port number in case the license does not 
work.
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Hostname of License Server

Type in the name of the computer acting as the host of your COSMOS license.

System Settings Tab

The System Setting page displays the detected host name, user name, Ethernet card 
address, and dongle id. If a dongle is detected and the Sentinel driver is not installed 
and running, click Install Sentinel driver. To request a new license, click the 
Request New License button. The Ethernet card and dongle ID’s are automatically 
passed to this dialog box if detected. You can make the request through the web or 
you can fax an automatically prepared message to SRAC. 

License Request

Select Host ID: Select a host ID from the drop-down menu (which contains 
detected Ethernet card address and/or dongle ID), or type in a different ID.
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License request option
• Launch COSMOS license request web page: Choose this option and 

click OK to file your request through the COSMOS License web page. Some 
of the fields are automatically filled out.

• Write Information to file: Choose this option and click OK to file your 
request by FAX. The administrator opens the Notepad text editor and 
automatically prepares the message. Save the file and fax it to SRAC.

Authorized Modules Tab

The Authorized Modules page lists the licensed features (modules and products). 

Available COSMOS License Files

Lists available COSMOS License files. You can set as a combination of license.dat 
files and server ports identified by port@host. The items in the list of files (or 
port@host) should be separated by semi colons (;). For Example, C:\Program 
Files\Cosmos\License\License.dat;7585@srac0369;7585@srac0370; 
7585@srac0371 is a valid list. All items in the above list will be searched/queried 
Click the Edit button to add a license file to the list.

Based on the list in the Available COSMOS License Files, the table lists the 
availability, license count (number of simultaneous user for floating licenses), 
license type, expiration date, and any remarks.

Click the Refresh button to update the table based on modified list of licenses.
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✍ The Remarks column lists the source of the license for each product.
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Server Settings Tab

The Server Settings page is to be used on the License Server machine. Using this 
page, you can install and configure the COSMOS License Server.

To configure the COSMOS License Server the system administrator will need the 
following information

1. Location of the lmgrd.exe file. This file is located in “…\License\FLEXlm” 
folder where “…” refers to the COSMOS\ installation folder. It is recommended 
that the user does not remove any files from this sub directory.

2. Location of the license file. It is recommended to keep the license.dat file 
(on the server machine) in the “…\License” folder.

3. Location of the log file. The end user can specify the location of the log file. The 
log file is useful for diagnosing and trouble-shooting license failures.

4. Location of the Options file. The end user can customize the license usage 
through the options file. Please refer to the FLEXlm end user manual 
(...\license\flexlm\enduser.pdf) to get more information about how to use an 
Options file. Where “...” refers to the COSMOS installation folder.

After the License servers are installed and running, you can view the contents of the 
log file to verify the licensed features
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The Configure COSMOS License Server button lets you point to the required 
files and host names of license servers.

Other buttons let you start, stop, re-read, and remove the license file, and display 
the log and license files.

Configuring Redundant License Servers

COSMOS License Scheme allows you to configure alternate license servers. 

The license file sent by SRAC for a 3 host license server configuration looks like:

SERVER host1 005004ad342d 7585 

SERVER host2 005004ad342e 7585 

SERVER host3 005004ad342f 7585 

VENDOR SRAC 

FEATURE DS_PARTS SRAC 2.000 1-JAN-2002 4 6E812F40ED34

FEATURE DS_ASSEMBLIES SRAC 2.000 1-JAN-2002 4 E08336FC8FBE
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where host1, host2 and host3 are the hostnames of the License Server machines at 
the end user site. To configure the 3 servers, the end user has to run the COSMOS 
License Administrator on each of the 3 machines. 

To configure the license server on a machine:

1. Click Start, Programs, COSMOS Applications, COSMOS License 
Administrator.

2. Click on the Server Settings tab.

3. Click Install COSMOS License Server button (or Configure COSMOS 
License Server, if the License server is already installed). 

4. The program detects the hostname of the machine executing the COSMOS 
License Administrator. However, you have to input the correct hostnames of 
the other 2 machines. For the license file displayed above, the screen below 
displays the scenario when the COSMOS License Administrator was 
executed on machine “srac0369”, whose host ID is 005004ad342d.

5. Click OK to install/configure the License Server.

6.  Repeat steps 1 through 5 on the other 2 License Server machines.

7. Check the log file to see if the License Servers are running.
COSMOSM Getting Started



Chapter 5   COSMOS License Administrator
Combine License Tab

The Combine License tab lets you combine license files. To combine the licenses, 
select the desired license files and click the Combine selected files. Check the Log 
file to make sure that all related daemons are started.

Current Usage tab

The Current Usage tab allows a License Administrator (on a server) to list all the 
current users of the floating license of various COSMOS applications. This tab 
appears on the License Server machine after the COSMOS License Server Service 
is installed. This tab is not activated for end users. Users of dongles, demo, and 
node-locked license are not listed.
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Choose the desired product and click the List Users button. The table lists the 
product, user name, host, and the last checkout date and time.
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6 Getting Started
Introduction

In COSMOSM, the user interacts only with the GEOSTAR interface. Internal calls 
and transfers of control to analysis modules are automated to give the user a one 
screen solution; the user builds the model, specifies all data required by the 
analysis, executes the suitable analysis module and evaluates the results, all from 
within GEOSTAR.

This chapter gives general information about GEOSTAR's main features and modes 
of operation. The material covered in the next sections includes a description of the 
GEOSTAR screen, various input options and some important database files. In 
addition, the chapter provides an outline of the general steps required for finite 
element analysis using COSMOSM.

This chapter will guide the user through model generation, analysis and 
postprocessing of a simple problem to help illustrate the basic operation of 
GEOSTAR as a preprocessing, analysis and postprocessing tool. However, 
GEOSTAR offers many advanced features and capabilities. Your skill in using it 
will grow with continued use. Additional examples to demonstrate different 
features of the program and types of analyses are presented in Chapters 5 and 6 of 
the COSMOSM User’s Guide. The online help includes an example that uses 
several types of elements.
COSMOSM Getting Started 6-1



Chapter 6   Getting Started

6-2
GEOSTAR Screen

After you install the program, start GEOSTAR by double-clicking the GEOSTAR 
icon in the COSMOS program group, or by clicking Start, Programs, COSMOS 
Applications, GEOSTAR. When you type the problem name in the Open Problem 
Files dialog box and press OK, all files related to this problem will have this name 
and some extensions determined by the type of information they contain. It takes 
GEOSTAR few seconds to set up the database files. The GEOSTAR opening 
screen, as shown in Figure 6-1, has three important areas:

1. Geo Panel
Menu names, describing the general functions of the commands in the menu, 
are located in the left hand side of the screen (see Figure 6-2). A command is 
issued by selecting the appropriate menu, submenus, and completing the 
associated dialog boxes.

2. Console Window
Command prompts and status messages appear in this area located at the bottom 
of the screen. Commands and input using the mouse or the keyboard are also 
shown in this area.

3. Display Window
Located in the center of the screen, this area is used to build and display the 
model. Several windows can be created in this area.

On-Line Help and List

GEOSTAR features two different types of on-line help: 1) brief one-line help 
messages at the bottom of the Display Window, and 2) a detailed help facility in a 
text mode for all commands is accessed by typing help followed by the command 
name or clicking on the help button in a dialog box.
COSMOSM Getting Started



Chapter 6   Getting Started
Modes of Operation

GEOSTAR can be operated in the following modes:

1. Interactive mode using pull-down menus, push buttons, mouse and the 
keyboard to interactively issue commands and respond to dialog boxes.

2. Semi-batch mode where the user, while in GEOSTAR, issues a command to 
read files with valid GEOSTAR commands. Valid files include files from other 
applications such as CAD programs (IGES and DXF formats) in addition to 
GEOSTAR files created in a GEOSTAR session or externally by an editor. The 
user can start in the interactive mode, read a file, and give commands 
interactively.

Figure 6-1. The GEOSTAR Screen
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Figure  6-2. Icons
 Push Buttons

Push buttons help users quickly select commonly used functions. The available 
icons are shown in Figure 6-2.

A push button can be activated by placing the mouse pointer on it and clicking the 
left button.

Menus

Appearing at the top of the Geo Panel, pull-down menus can be used to select and 
issue GEOSTAR cryptic and extended (or English-like) commands. The root 
menus are grouped based on the functions of commands. Some menus contain 
submenus. If a submenu is selected, the associated commands and submenus will 
appear. If a command is selected, it will also appear in the console.

These menus are:

Geometry for geometry development and processing.
Meshing for finite element meshing.
Propsets for specification of element groups, material properties, and real 

constant sets.
LoadsBC for loading and boundary condition specifications of various types 

of analyses.
Analysis for analysis options and executing analysis modules.
File for file processing.
Edit for editing geometry and finite element entities.
Control for activation and control of numerous processes during and after 

model generation including CAD interface options.
Display for display options.
Results for postprocessing operations.

Each category listed above is represented by a cluster of menus and submenus in 
which commands relevant to the function of that category are grouped together. In 
Appendix F of this manual, a brief description of GEOSTAR commands is given to 
provide a quick reference and outline of their capabilities.
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Input Options

Mouse Operations

The GEOSTAR program is designed to work best with a mouse. The mouse makes 
it easy to select a command from a menu, activate a push button, or select an entity 
from the screen:

1. Selecting a command.
Move the cursor arrow up to the desired menu. Click the left button to pull 
down a menu, and move the arrow down through the menu tree until you reach 
the command you need. Click the left button again to select the command or 
submenu.

2. Detailed command description.
Click on the “help” button in the Geo Panel or type “help” and the command 
name in the console window. A full screen display of detailed help for the 
command will appear.

3. Activating an icon.
Click once with the left button of the mouse. The icon you select will be 
activated and its function will be performed.

4. Selecting an item from the screen.
Point the mouse to the point, curve, surface or other entity you want to select, 
and click the left button of the mouse. GEOSTAR highlights the selected item 
and waits for your confirmation in the dialog box. Click the left button again to 
confirm the selection. If the highlighted item is not the one you want, press the 
right button to select the next available entity. Repeat the process until the 
desired item is highlighted, and then click the left button to select it. When an 
entity is highlighted, its label is also listed in the dialog box to ensure proper 
identification.

The Escape Key

The escape key aborts the current command and returns you to the GEOSTAR 
(GEO>) prompt.
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Keyboard Input

Although GEOSTAR is primarily designed for mouse input, users can enter 
commands through the keyboard as they become more proficient with the program 
and its commands. To use keyboard input, type the desired command in the console 
window, press Enter, and GEOSTAR will prompt you for the necessary inputs.

Important GEOSTAR Files

GEOSTAR opens a number of files by adding different extensions to the user-
furnished problem name (ufn). Most of the files are database files for internal use 
by GEOSTAR. The user does not need to interact with most of the files. GEOSTAR 
uses a number of files to provide help, and a number of other files for fonts and 
other internal purposes.

The important files that the user may need to access are as follows:

1. ufn.SES (session file)
This ASCII file stores all action commands issued during a session. The 
importance of the ufn.SES file comes from the fact that it contains the command 
history of the model and can be used accordingly to regenerate the model in 
case of lost or corrupted database. The file can also be used to generate a model 
on different computer systems.

2. ufn.GFM (geometric or neutral file format)
This is the default name for the file generated by the GFORM_OUT command. 
This file is similar to the session file in the sense that it can also be used to 
regenerate a model. The difference is that it is not chronological and the 
geometric entities are written in a neutral format. The user is encouraged to 
generate and keep this file. In addition to serving as an additional security 
measure, this file can save a lot of computer time in regenerating lengthy 
models in which extensive editing (deleting, undeleting, modifying and 
recreating entities) was used. The session file goes through all intermediate 
steps in generating the model, while the GFM file does not. The utility helps the 
user combine several parts of a model by using the FILE command to read the 
desired parts stored in.GFM files with proper offsets.

3. ufn.OUT (analysis output file)
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This file is an ASCII file generated during analysis. It contains details of the 
performed analysis input, results and messages. The user is advised to inspect 
the contents of this file in case of problems. In many situations, a message 
describing the cause of the problem will be written in the file. The amount of 
information written to this file is controlled by commands in the Analysis > 
Output Options submenu. For thermal analysis, the name of the output file is 
ufn.TEM.

4. Other files
GEOSTAR creates a number of other database files which contain the modeling 
information. These files are transparent to the user, and can be divided into two 
categories. The first group of files is the GEOSTAR database system, and the 
second contains files that are generated by other COSMOSM modules. More 
information is included in Appendix C.

Steps of the FEA Process in COSMOSM

In this section, it is recommended that a new user read about the commands that we 
refer to in order to get familiar with their overall functions. 

1. Decide the analysis type to be performed and the type of elements to be used for 
the model at hand. It is important to evaluate, and maybe actually solve, several 
alternative models.

✍ In COSMOSM, you must make sure to use consistent units in all your input.

2. Plan a strategy to build the model. Remember that the finite element mesh can 
be created either directly, by defining elements and nodes, or indirectly by 
creating and meshing geometrical entities. There are eight types of geometric 
entities in GEOSTAR: keypoints, curves, contours, surfaces, regions, volumes, 
polyhedra and parts. Although it is not always necessary to create and mesh 
geometric entities to generate a mesh, it would be advantageous in most cases to 
do so. Geometry is a very convenient way to generate a model, mesh it and 
apply the proper boundary conditions. Analysis modules, however, do not use 
the information about geometric entities since all the necessary information is 
associated with nodes and elements.
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3. Execute the GEOSTAR program in any work directory and give a name to the 
problem. This name is common to all files related to that problem. Each file has 
a different extension that determines the type of information it contains. These 
files are referred to as the database files for that problem. Any disk and 
subdirectory can be used. The creation of databases in the COSMOSM directory 
should be avoided in order to keep the system files intact. 

4. Define element groups, material properties and real constant sets using 
commands in the Propsets menu as follows:
a. Use the EGROUP (Propsets > Element Group) command to define all 

element groups to be used in the model.
b. Use the MPROP (Propsets >Material Property), PICK_MAT (Propsets > Pick 

Material Lib) or the USR_MAT (Propsets > User Material Lib) commands to 
define material properties needed for the analysis you plan to perform.

c. Use the RCONST (Propsets > Real Constant) command to define all needed 
sectional and other physical properties (real constant) sets.

5. Generate the geometry of the model. Take the time to think about your options. 
Take advantage of all types of symmetry in the light of GEOSTAR's meshing 
capabilities.

6. Activate the appropriate element attributes (element group, material property, 
and real constant sets) for parts of the model to be meshed next. Remember that 
whenever an element is generated by meshing, it assumes the active attributes. 
The ACTSET command (Control > ACTIVATE > Set Entity) can be used to 
change the active sets.

7. Evaluate various options of meshing. Select and issue the appropriate command 
to generate the mesh for the corresponding part of the model. In large models, 
use a finer mesh only at critical locations in order to more efficiently develop 
and analyze your model.

8. Repeat steps 6 and 7 as needed. Change one or more of the active sets and mesh 
the corresponding part. Verify the compatibility of the mesh.

9. List the elements by Edit > LIST > Elements. Verify that elements have the 
proper attributes. The Change El-Prop command (in Propsets menu) can be 
used to change the attributes of existing elements. The Analysis > Data Check 
command verifies that all needed attributes for an element have been defined. 
The Analysis > Run Check command does more elaborate checking including 
element connectivity. The user is advised to read the help on these commands.
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10. Read the help and then issue the command, Meshing > NODES > Merge. You 
might need to specify a tolerance value that is different from the default. If 
nodes belonging to adjacent parts with a common boundary are not merged, 
then these nodes are not attached (unless coupled), and could separate during 
analysis. Please read the on-line help for this command.

11. Use the LoadsBC menu to specify the proper loading and boundary conditions. 
Remember that the specified options are associated with the active coordinate 
system which could be Cartesian, cylindrical or spherical. If the specified 
constraints are not enough, the stiffness matrix (or the equivalent for other 
analyses) will be singular.

12. Evaluate your model by plotting it in various views and settings. Commands in 
the Display menu provide you with all the necessary tools. Use multiple colors 
and zoom-in on critical parts. Listing and plotting of various loading and 
boundary conditions are also recommended.

13. Use one of the “..... Analysis Options” family of commands in the Analysis 
menu and the associated submenus to specify the details of the desired analysis. 
The Frequency Options command, for example, specifies the details of the 
procedure to be used in extracting the eigenpairs (the eigenvalues and mode 
shapes). The program assumes all default values if the corresponding command 
is not issued. The List Analysis Option command can be used to list the active 
analysis options.

14. Use one of the “Run....” family of commands in the Analysis menu to transfer 
control to the corresponding module to perform the analysis and generate the 
desired results.

15. If the analysis does not go through successfully, a message will be printed on the 
screen. This message is also printed in the .OUT (.TEM for thermal analysis) 
file. Correct the error and run the analysis again.

16. When the GEOSTAR screen returns, pull down the Results menu and study the 
available commands. Deformed shapes can be directly plotted and animated for 
structural problems using the Deformed Shape and Animate commands 
(Results > PLOT > ...). Contour plots for all types of analyses can be generated 
by activating the desired quantity, and plotting it. The Analysis Type button can 
change the active type of analysis for postprocessing. Results can also be listed 
on the screen using commands available in the Results > LIST and Results > 
EXTREMES menus.
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17. Evaluate the validity of the results by common engineering sense and any 
experimental or theoretical data. If the actual results are too far from the 
expected results, review your modeling assumptions, element types, meshing 
and other input such as dimensions, units, and material properties. Correct any 
input errors and repeat the analysis. If there is little or no improvement 
accomplished, redefine the mesh, use finer elements and repeat the analysis.

18. Repeating the analysis with a finer mesh builds confidence in the results and 
will approach the exact solution in most cases. If you are solving a linear static 
structural problem you might use the H- or the P-method where the decision of 
mesh improvement at automatically selected portions of the model relies on an 
error estimate. (Read the on-line help on the ADAPTIVE (Analysis > STATIC > 
Adaptive Method) command).

COSMOSM in Action

A comprehensive step-by-step example is given in this section to provide the user 
with the necessary information for a confident and fast start. By the end of this 
example, you will be familiar with the basic features of GEOSTAR for 
preprocessing, analysis and postprocessing.
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Description of the Problem

A square steel plate shown in Figure 6-3 
is subjected to in-plane forces of 
magnitude 1,000 units around the edge of 
a circular hole in the X- and Y-directions. 
The forces in the X- and Y-directions are 
treated as multiple load cases to study 
their combined effect in the 
postprocessing phase. The square plate 
has a side length of 100 units and the 
thickness is 0.2 units. The radius of the 
circular opening at the center is 10 units. 
The plate is modeled with 2D plane 
stress elements. These elements have two 
degrees of freedom per node (X- and Y-
translations) and must be in the X-Y 
plane unless the CSREF2D command is 
issued to specify some other plane. 

The material of the plate has an elastic modulus of 30 x 106 and the Poisson's ratio 
is 0.3. The plate is fixed at the top and bottom edges.

It is suggested at this point that the user reads about the units in Appendix B. In this 
example, the unit of length is inches, unit of weight is pound, and that of time is 
second. The modulus of elasticity should be given in lb/in2, forces in lb and the 
units of resulting displacements are in inches and stresses are in lb/in2.

There are several ways to model this problem. Since this is a plane model, surfaces 
and regions can be used. In the approach illustrated below, a surface is created and 
meshed to represent a quarter of the model. The rest of the model is created by 
generating similar meshed surfaces. The steps are shown in detail in the following 
sections.

Entering GEOSTAR

It is always preferable not to work in the COSMOSM directory; the user should use 
the working directory created after installation or create a new working directory.

Double click on the GEOSTAR icon to start GEOSTAR. Use the File, Save Da-

tabase As command to name the new problem as Plate.

Figure 6-3. Square Plate with a Hole
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When you enter “Plate” as a name for the problem, all files related to this problem 
will have this name and some extension determined by the type of information they 
contain. It takes GEOSTAR few seconds to set up the database files before 
returning to the GEOSTAR console with the “GEO>” prompt. GEOSTAR is now 
ready to accept commands which can either be typed at the prompt level or pulled 
down from the menus.

Specifying Properties

It is a good practice to define element groups, materials, and real constant sets in 
the beginning. All related commands are found in the Propsets menu.

Specifying the Element Group 

I. Geo Panel: Propsets > Element Group

Element group number: 1
Egroup Category: Area

Element Name: PLANE2D

Click Continue as prompted and then OK to accept the defaults associated 
with the element group

Specifying Material Properties

Next, define the material 
properties. In this case (linear 
elastic material) the only needed 
properties are the Elasticity 
Modulus (EX) and Poisson’s Ratio 
(NUXY).

II. Geo Panel: Propsets > 
Material Property

Material property set number: 1
Material property name: EX

Value of the material property (EX): 30e6

Click Continue to define more material properties for material property set 1
Material property name: NUXY

Value of the material property (NUXY): 0.30

Click Cancel to conclude material property entries for set 1
 

Figure 6-4. Dialog Box for EGROUP
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Figure 6-5. Dialog Boxes for MPROP

Poisson’s Ratio (NUXY) is assumed to be 0.30 if not specified.

Specifying Real Constants

Next, the section properties are defined using a real constant set.

III. Geo Panel: Propsets > Real Constant

Associated element group: 1
Real constant set number: 1
Click Continue to define information about real constant set 1
Starting location of the real constant: 1
Number of real constants associated with real constant set 1: 2
Real constant RC1 (Thickness): 0.2

Click OK to accept real constant entries for set 1

Figure 6-6. Dialog Boxes for RCONST
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List and Verify Your Inputs

To verify the element group, material properties and the real constants you have 
just input you can proceed as follows:

 I. Geo Panel: Edit > LIST > Element Groups

Beginning element group number: 1
Ending element group number: 1
Increment: 1
Click OK to accept the entries for element group listing

Similarly, you can list material properties 
and real constants.

Setting the View

For this 2D problem, the model is created 
in the X-Y plane.

First, clear the Display Window by clicking on the 
Clear button in the Geo Panel. Then adjust the 
view inside the Display Window. Open the dialog 

box for view setting by clicking on in the 
view panel.

I. Geo Panel: View Direction icon

Click on the “XY-View” button 

Close the View

Setting the Grid

GEOSTAR requires you to set up a grid if you want to snap keypoints with the 
mouse. To display the grid, the plane where the grid is to be displayed should be 
set. A plane is defined by its normal (the Z-axis in this case).

I. Geo Panel: Geometry > GRID > Plane

Rotation/Sweep Axis: Z
Offset on the Z-axis: 0.0

Click OK to accept the entries

Figure 6-7. Dialog Box for EGLIST

Figure 6-8. Dialog Box for 
View Setting
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 II. Geo Panel: Geometry > Grid On

Click OK to accept the defaults

Figure 6-9. Dialog Boxes for Grid Setting

GEOSTAR will define a grid starting from the origin of the axes, with 20 divisions 
on each axis representing 5 units each. This will allow for maximum coordinate 
values of 100 for both X and Y on the grid. The dimensions of the grid can be 
specified as desired.

Creation of Quarter of the Model

Click on the STATUS1 button in the Geo 
Panel, a table will be displayed in which 
current information on the status of several 
flags controlling the plotting of geometrical 
entities (keypoints “PT”, curves “CR”, 
surfaces “SF”, etc.), their colors, labels, 
label colors and other options are shown. 
The table lets you toggle the flags to ON/OF 
and select the color of the various entities. 
We will change the label status of points, 
curves, and surfaces from OFF to ON. 
Although this process is not always required, 
we need it in this example to make it easier 
for you to follow the modeling procedure. 
The operation is accomplished by placing 
the mouse cursor on ON/OFF flags for PT, 
CR, and SF and then pressing the left button of the mouse to switch from OFF to 
ON. After making the three changes, save them by clicking on Save.
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Point Generation

Now, you need to create a keypoint at the center of the plate.

I. Geo Panel: Geometry > POINTS > Define

Keypoint number: 1
XYZ-Coordinate value: (50, 50, 0)

Click OK to accept the entries

Repeat the above command to specify two additional keypoints (points (0.0, 
100,0.0) and (100, 100, 0.0)). Then, by using these two points create a straight line 
to define the top edge of the plate.

Curve Generation

 II. Geo Panel: Geometry > CURVES > Line with 2 Pts

Curve number: 1
Keypoint 1: 2
Keypoint 2: 3
Click OK to accept the entries

The upper edge (curve 1) connecting keypoints 2 and 3 will be created.

III. Geo Panel: Geometry > CURVES > CIRCLES > Circle in Plane

Curve number: 2
Keypoint at center: 1

You can pick the keypoint by moving the mouse arrow to the keypoint 
and clicking on it once. The keypoint will be highlighted and its label 
will appear in the dialog box. Confirm your choice by clicking once 
more.

Keypoint on 0 degree line: 3
Radius of the circle: 10

Angle of the arc (in degrees): 90

Number of segments: 1
Click OK to accept the entries

The model is shown in the following 
figure, with grid lines removed. Notice 
that the labels of points and curves are 
displayed only because we activated their 
flags in the STATUS1 table.

Figure 6-10. Dialog Box for Curves 
Definitions
COSMOSM Getting Started



Chapter 6   Getting Started
Surface Generation

Next, create a surface using two curves 
(curves 1 and 2). 

IV. Geo Panel: Geometry > 
SURFACES > Define by 2 Cr

Surface number: 1
Curve 1: 1
Curve 2: 2
Underlying surface: 0
Click OK to accept the entries

At this point, you can turn off the grid 
lines using the Grid Off command in the 
Geometry > GRID menu. The model is 
shown in the following figure with grid 
lines removed, after clicking the Paint 
button.

Mesh Generation

 V. Geo Panel: Meshing > 
PARAMETRIC MESH > 
Surfaces

Beginning surface 
number: 1
Ending surface number: 1
Increment: 1
Number of nodes per 
element: 4
Number of elements on 
1st curve: 3
Number of elements on 
2nd curve: 3
Click OK to accept the 
defaults of spacing ratios 
for 1st and 2nd curves

Figure  6-11.Creation of Curves 1 
and 2 for Quarter Model

Figure 6-12. Surface 1 Generation 
from Curves 1 and 2
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The mesh generated is shown in the following figure.

Figure 6-13. Meshing of Surface 1

Generation of the Rest of the Model

The rest of the model will be created by generating three more surfaces by rotating 
the existing surface as well as the elements generated about an axis normal to its 
plane that passes through the center. To do this, we need first to create the proper 
coordinate system. 

I. Geo Panel: Geometry > COORDINATE SYSTEMS > 3 Angles

Coordinate system number: 3
Coordinate system type: Cartesian

XYZ-coordinate value of origin: (50, 50, 0)
Click OK to accept the rest of the entries

The created system, system (3), is now active.

Since we would like to automatically generate the remaining three surfaces similar 
to surface 1, the default meshing flag should be activated.

II. Geo Panel: Control > ACTIVATE > Default Meshing

Entity: SF

Default mesh flag: On

Click OK to accept the rest of the entries
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The flag can also be activated by using the Status1 button and by toggling on the 
flag under DMSH column for surfaces. 

We are now ready to generate the rest of the model.

III. Geo Panel: Geometry > SURFACES > GENERATION MENU > Generate

Generation Number: 3
Beginning surface number: 1
Ending surface number: 1
Increment: 1
Generation flag: Rotation

Click Continue
Z-rotation: 90

Click OK to accept the rest of the entries

The generated model is shown in the 
figure.

Node Merge and Compress

The model has 4 surfaces, 12 curves, 9 
keypoints, 36 elements and a total of 64 
nodes. The meshing process has 
generated some coincident nodes at the 
common boundaries between surfaces. 
Coincident nodes can be merged using 
the MERGE (Meshing > Nodes > 
Merge) command. Note that in some 
cases (e.g. contact problems) 
coincident nodes should not be merged 
to allow relative motion. 

I. Geo Panel: Meshing > NODES > Merge 

Click OK to accept the entries in the dialog box
16 nodes will be merged.

After the merging process, the node numbering will not be consecutive. In finite 
element analysis, the node numbers are not required to be continuous and no action 
is needed to remove the numbering gaps. However, it is a good practice to 
compress nodes. 

II. Geo Panel: Edit > COMPRESS > Nodes

Figure 6-14. Generation of the Full Model
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Click OK to accept the entries in the dialog box
13 nodes will be compressed.

Specifying Loads and Boundary Conditions

GEOSTAR allows you to specify loading and boundary conditions on geometric 
entities. The actual loading or boundary condition is applied to nodes, element 
faces, or elements associated with the specified geometric entities. Clear the 
window display by clicking on the Clear button. In order to apply constraints and 
forces on the curve entities, you need to plot them. 

I. Geo Panel: Edit > PLOT > Curves

Click OK to accept the entries in the dialog box

The directions of constraints are interpreted with respect to the active coordinate 
system. Any coordinate system can be used to specify these boundary conditions. 
In this problem we need to activate the global Cartesian system.

II. Geo Panel: Control > ACTIVATE > Set Entity

Select set label: Coordinate System

Click Continue
Coordinate system number: 0
Click OK to accept

We will start by constraining the upper edge of the plate (curve 1).
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III. Geo Panel: LoadsBC > 
STRUCTURAL > Displace-
ment > Define by Curves

Beginning curve: 1
Displacement label: UX

Value of the prescribed 
value: 0
Ending curve number: 1
Increment between curves: 1
Displacement label: UY

Click OK

Similarly, constrain the bottom edge 
(curve 9). Now, if you plot the 
element (Geo Panel: Edit > PLOT > 
Elements), the plate with boundary 
conditions you just defined will be 
displayed as shown in the figure. 

It should be noted that GEOSTAR automatically fixes degrees of freedom that are 
not considered by the element at execution time. The Z-translation and all rotations 
are automatically set to zero since the PLANE2D element considers only X- and Y-
translations.

Loading is specified next. We will apply a force of 1000 lb in the X-direction at 
every node on the circle (i.e. curves 2, 7, 10 and 12). Clear the display window by 
clicking on the Clear button in the Geo Panel then replot all curves (Geo Panel: 
Edit > PLOT > Curves). Then start applying the forces.

IV. Geo Panel: LoadsBC > STRUCTURAL > Force > Define by Curves

Beginning curve: 2
Displacement label: FX
Value of the prescribed value: 1000

Ending curve number: 12

Increment between curves: 5
Click OK to accept the entries

Figure 6-15. Applied Boundary Conditions
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Repeat the above step to define the 
forces on the nodes associated with 
curve 10. Then clear the screen, and 
replot the elements, boundary 
condition and forces. The model will 
be as displayed in the following 
figure. The specified forces are 
associated with load case number 1 
since no other load case was 
activated. In this example we will 
use two load cases. Load case 2 will 
be used to define vertical forces 
(FY) on the circular opening. 

V. Geo Panel: Control > 
ACTIVATE > Set Entity

Set label: Load Case

Click Continue
Load case number: 2
Click OK

In a similar way, define a force of 1000 lb at each node on the circle in the Y-
direction. The figure shows forces applied under load case number 2.

Figure 6-17. Load Case 2: Forces in the Y-Direction

Figure 2-16. Load Case 1: Forces in 
the X-Direction
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Model Evaluation

Since your analysis results will only be as good as the model you build, you need to 
evaluate it for accuracy and completeness. This step involves plotting the elements, 
the boundary conditions, and the applied forces so that you can inspect them. Start 
with clearing the window display by clicking on the Clear button. Then plot and list 
the elements.

I. Geo Panel: Edit > PLOT > Elements

II. Geo Panel: Edit > LIST > Elements

In a similar way you can plot and list the boundary conditions (LoadsBC > 
STRUCTURAL > DISPLACEMENT > Plot) and the applied forces (LoadsBC > 
STRUCTURAL > FORCE > Plot). Note that only forces associated with the active 
load case (load case 2) are plotted. To plot forces associated with load case 1, you 
need to activate it using the ACTIVATE command.

III. Geo Panel: Control > ACTIVATE > Set Entity

Set label: Load Case

Click on Continue
Load case number: 1
Click OK to accept

Then you can list the forces associated with load case number 1.

Now, you have a complete finite element model of a plate structure with a hole, 
along with applied boundary conditions, and forces in two load cases. The Zoom-In 
button in the Zoom/Pan/Rotate area of the Geo Panel can give you a close look of 
the different areas of the model. You can also check your model by the following 
commands:

IV. Geo Panel: Analysis > Data Check

V. Geo Panel: Analysis > Run Check

Please read the on-line help for these commands.

Analysis

We will consider linear static and frequency analyses for this model. First, the 
linear static analysis will be performed. You may access the A_STATIC (Analysis > 
STATIC > Static Analysis Options) to specify the details of the analysis and turn 
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on the necessary flags. In this example all default values will be used; thus, there is 
no need to issue this command. However, if you issue the command, you can click 
to accept the default values. Then, perform the analysis.

I. Geo Panel: Analysis > STATIC > Run Static Analysis

GEOSTAR will display status messages as it runs the analysis module. When the 
analysis is completed, the program will return to the Display Window and wait 
for your next instruction. Note that an automatic stress calculation is performed by 
default. However, it can be deactivated by using the STRESS (Analysis > 
STATIC > Activate Stress Calc) command and setting the stress calculation flag 
off. Displacements and stresses are calculated for all load cases.

Next, perform a linear frequency analysis to calculate the lowest four natural 
frequencies and their corresponding mode shapes.

II. Geo Panel: Analysis > FREQUENCY/BUCKLING > Frequency Options

Number of required modes: 4
Click OK to accept the rest of the defaults

Since the computation of natural frequencies involves the use of mass matrix, you 
need to define material density or some lumped masses. Otherwise, the program 
will terminate because of a null mass matrix. So, define the material density.

III. Geo Panel: Propsets > Material Property

Material property set number: 1
Material property name: DENS

Value of the material property (DENSITY): 7.5e-4

Click OK and then Cancel before the next property

To append the results of the frequency analysis to the same “plate.OUT” file 
containing the linear static analysis results you need to turn the append flag on in 
the printing of the output file. Otherwise, the “plate.OUT” file will be overwritten. 
Then run the frequency analysis.

IV. Geo Panel: Analysis > OUTPUT OPTIONS > Set Print Options

Turn on the append to the output flag
Click OK to accept the rest of the defaults

V. Geo Panel: Analysis > FREQUENCY/BUCKLING > Run Frequency

As before, GEOSTAR will display status messages related to normal modes of 
calculation as it runs the analysis module. At this point, the two analyses are 
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completed and you are ready to evaluate the results directly from GEOSTAR for 
both of them. 

Results

In the postprocessing phase, several options are available.

1. You may examine the results written in the problem output file. This can be 
done using your preferred editor from the operating system level, or you can go 
to (File > Edit a File) and open the problem output (Plate.out) file.

2. You may list the model displacements and stresses using the commands 
provided in: Geo Panel: Results > LIST. You can also list extreme values of a 
displacement or a stress component (Geo Panel: Results > Extremes).

3. Finally, graphic postprocessing may be performed to examine deformations, 
displacements, stresses and mode shapes. 

You are now ready to start looking at the results for both linear static and frequency 
analyses. Frequency analysis is the active type for postprocessing since it was 
performed last. Create four windows by clicking on the New Win button in the Geo 
Panel 3 times, then click on the Tile button  in the Geo Panel to place the 
windows in a tile formation.

Note that window 3 is the active window since it is the most recently created. To 
activate the Main window, move the mouse to a place inside the Main window and 
click. Adjust the view inside the window to the XY-plane. Then, plot the first mode 
shape inside the first window.

I. Geo Panel: View Direction icon

Click on the Z-View button
Close the View

II. Geo Panel: Results > PLOT > Deformed Shape

Mode shape number to be plotted: 1
Click OK to accept the defaults

The above procedure can be repeated to plot modes shapes 2, 3, and 4 in the 
corresponding windows. The results are shown below in the following figure.
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Figure 6-18. Frequency and Mode Shape Results from the Frequency Analysis

You can also animate any of the four mode shapes. For example, to animate the first 
mode shape active the first window, clear the first window and then use the 
Animate command.

III. Geo Panel: Results > PLOT > Animate

Mode shape number to be animated: 1
Click OK to accept the defaults

You can repeat the above procedure to animate mode shapes 2, 3, and 4 in the 
corresponding windows.

To switch to the postprocessing of the linear static analysis, use the Set Post button 

 in the Geo Panel to select the postprocessing for Linear Structural 
analysis. Load case 1 will be processed first. The deformed shape will be plotted in 
window 1. Displacement resultant and von Mises stress contours will be plotted in 
window 2 and 3 respectively. Activate and clear the first window 1 (use the push 
buttons in the Geo Panel). 

IV. Geo Panel: Results > PLOT > Deformed Shape

Number of the load case to be plotted: 1

Click OK to accept the defaults
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Then activate and clear the second window.

V. Geo Panel: Results > PLOT > Animate

Number of the load case to be animated: 1
Click OK to accept the defaults

A snapshot of the animated deformation is shown in window 1 of Figure 6-20.

Next, we will produce a displacement contour in window 2 and a stress contour plot 
in window 3.

• VI.Geo Panel: Results > PLOT > Displacement/Response/Reaction

Load case number: 1
Component: URES: Resultant Displacement

Click on Contour Plot to select contour plot
Click OK to accept the defaults of the contour plot dialog box

Nicer contour plots may be obtained by suppressing the plotting of element edges 
and plotting the boundaries of the model. 

VII. Geo Panel: Display > DISPLAY OPTIONS > Eval Element Bound

Turn on the Boundary edge evaluation flag
Click OK to accept the defaults

Next, activate window 3 to plot the stress (the von Mises stresses are selected in 
this example).

VIII. Geo Panel: Results > PLOT > Stress

Load case number: 1
Component: VON: von Mises Stress

Click Contour Plot to select contour plot
Click OK to accept the defaults of the contour plot dialog box
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Figure 6-19. Results from Load Case 1

The user is encouraged to try various options in plotting the displacement and stress 
results.

Load case 2 can be processed similarly. Results are shown below in the following 
figure.
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Figure 6-20. Results from Load Case 2

 You can trace the variation of results (stresses and displacements in this problems) 
along an arbitrary path defined by up to 20 nodes. The results are viewed on an 
XY-type graph in an automatically created window. The X-axis represents the 
normalized distance starting from the path’s first node and the Y-axis refers to the 
variation of results. Let’s find stress variation for load case 2, as displayed in 
window 3.

IX. Geo Panel: Results > PLOT > Path Graph

You can use ANIMATE (Geo Panel: Results > PLOT > Animate). The path 
variation graph is shown in Figure 2-22.
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Figure 6-21. Path Variation of von Mises Stresses for Load Case 2 Along a Line

Secondary Load Cases

Before concluding this example, the procedure to define, analyze, and process 
multiple load cases is outlined. 

X. Geo Panel: Results > Combine Load Case

New load case number: 51

Load case number for first term: 1
Load case factor for first term: -1
Load case number for second term: 2
Load case factor for second term: 2.0

Click OK to conclude the command

GEOSTAR uses these factors to calculate results for load case 51. The results for 
load case 51 can be list, plotted and animated in a similar way to load cases 1 and 2. 
Results for load case 51 are shown in the figure below.
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Figure 6-22. Results from Load Case 51

Exercises

There are many ways to create the model shown in previous sections in GEOSTAR. 
It is recommended that the user try alternative ways to create the same model. New 
problems can be created by exiting GEOSTAR and then re-entering it using a 
different problem name, or by using the NEWPROB (File > New...) command while 
in GEOSTAR. 

First Exercise
• Create a new problem.
• After setting the view and the grid, use the CRPCORD (Geometry > CURVES > 

Draw Polyline) command to draw the outer boundaries of the plate.
• Create the center keypoint and use the CRPCIRCLE (Geometry > CURVES > 

CIRCLES > Circle in Plane) command to draw the circular opening.
• Use the SF2CR (Geometry > SURFACES > Define by 2 Cr) command to create 

four surfaces. Each surface is created from a straight edge and an arc. 
• Use the M_SF (Meshing > PARAMETRIC MESH > Surfaces) or the MA_SF 

(Meshing > AUTO MESH > Surfaces) to mesh the four surfaces at once.
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Second Exercise
• Create a new problem.
• Create a keypoint by specifying the coordinates of a corner.
• Use the CREXTR (Geometry > CURVES > GENERATION MENU > 

Extrusion) command to generate one outer straight edge by extruding the 
generated keypoint in the proper direction. 

• Repeat the CREXTR command three times to create the other straight edges of 
the plate.

• Create the center keypoint and the hole using the PT and the CRPCIRCLE 
commands (examine ways to create circles by reading the on-line help for 
commands in the Geometry > CURVES > CIRCLES submenu). Use 12 
segments to represent the circle. Use the CT (Geometry > CONTOURS > 
Define) command to create contour number 1 from the outer edges, any one 
curve should be sufficient to define the contour since no alternative ways are 
available to close the loop. Specify an average element size of 10.

• Use the CT command again to define contour number 2 as the edges of the hole. 
Again any arc should be sufficient to define this contour. (You might try the 
CTNU contour to define the number of elements on each single curve instead of 
CT).

• Use the RG (Geometry > REGIONS > Define) command to create region 
number 1 using contours 1 and 2.

• Use the MA_RG (Meshing > AUTO MESH > Regions) command to mesh 
region 1. The generated mesh will be triangular.

• Use the MARGCH (Meshing > AUTO MESH > Region Mesh Type) command 
to update the mesh to quadrilateral elements.

Third Exercise

When we applied forces on nodes associated with curves 2, 7, 10 and 12, we had to 
do that in two steps since no one pattern can include all of them. A powerful utility 
called selection lists can be very helpful in such cases. Use the SELWIN (Control > 
SELECT > By Windowing) command to select the curves of the circle, use the 
FCR (LoadsBC > STRUCTURAL > FORCE > Define Curves) command to apply 
forces on all curves. GEOSTAR will apply forces only on elements associated with 
curves in the selection list. Use the INITSEL (Control > SELECT > Initialize) 
command to initialize the curves selection list.
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Fourth Exercise
• Gravity, centrifugal and thermal loading are referred to as special loading in 

GEOSTAR.
• The user is encouraged to include gravity loading for the given example, the 

steps are as follows:
• Issuing the A_STATIC (Analysis > STATIC > Static Analysis Options) 

command, read the help and specify “G” for the special loading flag.
• Specify a value for the acceleration of gravity in the X or Y directions using the 

ACEL (LoadsBC > STRUCTURAL > GRAVITY > Define Acceleration) 
command. Special loading is added to other forces and pressure for the active 
load case. Concentrated masses or a value for density must be specified.

Fifth Exercise
• Define thermal conductivity, KX, using the MPROP (Propsets > Material 

Property) command.
• Use the NTCR (LoadsBC > THERMAL > TEMPERATURE > Define Curves) 

command to apply a temperature of 200° around the hole. Specify the 
temperature on the edges to be 25°.

• Issue the R_THERMAL (Analysis > HEAT TRANSFER > Run Thermal 
Analysis) command to run a heat conduction analysis.

• Use the ACTTEMP and TEMPPLOT (Results > PLOT > Thermal) commands to 
load and plot temperature contours.

• Use the A_STATIC,T (Analysis > STATIC > Static Analysis Options) 
command to specify thermal loading.

• Issue the R_STATIC (Analysis > STATIC > Run Static Analysis) command to 
perform linear static analysis based on the temperature profile obtained from the 
thermal analysis.

Working with CAD Systems

In this section, you will learn how to analyze models created in other CAD 
programs. You will find how easy it is to work with models generated in CAD 
programs in GEOSTAR environment through the incorporation of a very powerful 
IGES translator. A list of the CAD systems that you can work with inside 
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GEOSTAR is available by issuing the command CAD_INP (Control > 
CAD_System > Read CAD Input).

Description of the Problem

We will analyze a bracket model. The model is subjected to the loads and boundary 
conditions shown in figure.

Figure 6-23.  Bracket Model with Loads and Boundary Conditions

The bracket is modeled with TETRA10 solid elements. These elements have 3 
translational degrees of freedom per node. As we did in the first example, we will 
start by defining element groups and material properties, applying loads and 
boundary conditions, then running the analysis and visualizing the results.

Starting GEOSTAR
Double click on the GEOSTAR icon to start GEOSTAR. Use the File, Save 
Database As to name the new problem as Bracket_Model.
Enter a name for the problem: Bracket_Model

Importing the Model into GEOSTAR

To import the bracket model into GEOSTAR:

I. Geo Panel: Control > CAD_System > Read CAD Input

CAD system: Pro/E 18+, PT/M 2+

Fixed faces

 Normal pressure
 of 500 psi
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CAD model IGES file name: Click Find button and navigate to the Brack-
et.igs file located in the  “...\exampleproblems”  folder where “...” refers to 
cosmosm installation directory.
Click OK

In order to ease the process of applying loads and boundary conditions later on, it is 
recommended to reorient the model by performing a successive rotations about the 
global coordinate axes using rotation buttons. We will perform rotations about the 
X-axis first, followed by rotations about the Z-axis as follows:

 II. Geo Panel: Click the X-axis button  

Click the rotation button  five or six times

Click the Z-axis button  

Click the rotation button  five or six times

The Bracket model will be oriented as shown in the figure below:

Figure 6-24.  Orienting the Bracket Model

Specifying Properties

It is a good practice to define elements groups, materials, and real constant sets in 
the beginning. All related commands are found in the PropSets menu.
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Specifying the Element Group 

I. Geo Panel: Propsets > Element Group

Element group number: 1
Egroup Category: Volume (for the Unix version only)
Element Name: TETRA10: 10-node tetrahedral solid element

Click Continue 
Click OK to accept the defaults associated with the element group

Specifying Material Properties

Next, define the material properties.

II. Geo Panel: Propsets > Pick Material Lib

Material property set: 1
Material Name: A_STEEL: ALLOY STEEL

Unit Label: FPS: British (Inch/Pound/Second)

Click OK
 

Figure 6-25. Dialog Box for Applying Material to the Bracket

There is no real constant associated with TETRA10 element.

List and Verify Your Inputs

To verify the element group and the material properties you have just input you can 
proceed as follows:

 I. Geo Panel: Edit > LIST > Element Groups

Beginning element group number: 1
Ending element group number: 1
Increment: 1
Click OK to accept the entries for element group listing

Similarly, you can list the material properties.
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Meshing the Model

We will mesh the model with the default element size. To see the default element 
size:

I. Geo Panel: Edit > LIST > Polyhedra

Beginning Polyhedron: 1
Ending Polyhedron:1
Increment:1
Click OK

The polyhedra list window opens. Under the Elem_size column a uniform element 
size of 0.668759 is assigned to all regions of the polyhedron.

Figure 6-26. Listing the Polyhedra of the Bracket

To mesh the model with the default element size:

I. Geo Panel: Meshing > Auto_Mesh > Parts

Beginning Part: 1
Ending Part:1
Increment:1
Hierarchy check flag: 0: NO

Element order flag: 0: 1: High

Number of smoothing iterations: 4
Click OK
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Figure 6-27.  Meshing the Bracket Part

To view the mesh in the shade mode:

I. Geo Panel: Display > Display_Option > Shaded Element Plot

Shaded plot flag: 1: Flat shade

Positive normal side color: 4: Red

Negative normal side color: 7: Gray

Tolerance intensity for Gouraud shading: 0.2

Click OK

Click the Repaint button  to refresh the screen

The following model will be displayed

Figure 6-28.  Bracket Model with Finite Element Mesh

Applying Loads and Boundary Conditions

We will fix the inside regions of the holes on the two side walls of the bracket. You 
can either type in the region number in the DRG dialog box or you can select it 
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from the display area by the mouse. If you choose the latter option, you will need to 
plot the regions of the model. To do so, clear the screen by clicking the Clear button 

, then issue the command RGPLOT (Edit > Plot > Regions).

To fix the faces of the holes:

I. Geo Panel: LoadsBC > Structural > Displacement > Define by Regions

Beginning Region: 26

Displacement label: AU: All translations

Value: 0
Ending Region: 26

Increment: 1
Click OK

Figure 6-29.  Applying Displacement Boundary Conditions

Repeat this procedure for regions 13, 15, and 28.

Next, we will apply a pressure of magnitude 500 psi normal to the bottom face of 
the bracket as follows:

I. Geo Panel: LoadsBC > Structural > Pressure > Define by Regions

Beginning Region: 51

Pressure magnitude: 500

Ending Region: 51

Increment: 1
Unused option: 0
Pressure direction: 4: Normal

Click OK
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Figure 6-30. Applying Pressure Load

The following figure shows the applied boundary condition and loads on the finite 
element mesh of the bracket.

Figure 6-31.  The Complete Finite Element Model of the Bracket Part

Performing the Analysis

We will consider linear static analysis for this model. To view or modify the static 
analysis options, issue the command, A_STATIC (Analysis > Static > Static Analysis 

Options). In this example all default values will be used; thus, there is no need to 
issue this command. To perform the static analysis:

I.     Geo Panel: Analysis >Static > Run Static Analysis

GEOSTAR will display status messages as it runs the analysis module. When the 
analysis is completed, the program will return to the Display Window and wait for 
your next instruction.
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Postprocessing of the Static Analysis Results

In the postprocessing phase, several options are available:

• You can examine the results written in the problem output file. This can be done 
using your preferred editor from the operating system level, or issue the 
command (File > Edit a File) from the File menu.

• You can list the model displacements and stresses using the commands provided 
in: Geo Panel: Results > LIST. You can also list extreme values of a 
displacement or a stress component (Geo Panel: Results > Extremes).

• Finally, graphic postprocessing may be performed to examine deformations, 
displacements, and stresses.

Visualizing Stress Results

To generate a contour plot for the von Mises stress:

I. Geo Panel: Results > Plot > Stress

Load case number: 1
Component: VON: von Mises Stress

Stress flag: 1: Node

Layer number: 1
Face flag: 0: Top

Coordinate System: 0
Click Contour Plot 

Click OK to accepts all the defaults
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Figure 6-32.  Von Mises Stress Contour Plot

To suppress the display of the element boundaries in the von Mises stress plot, we 
will use the BOUNDARY command (Display > Display_Options > Set Bound Plot). 

I. Geo Panel: Display > Display_Options > Set Boundary Plot

Boundary plot: 0: None

Geometry associated boundary flag: 1: Yes

Click OK

II. Click on the Paint button to replot the stress contour plot without element 
boundaries as shown below.

Figure  6-33.  Von Mises Stress Plot After Executing the BOUNDARY Command
COSMOSM Getting Started



Chapter 6   Getting Started
To generate a section plot for the von Mises stress in the same window:

I. Geo Panel: Results > Plot > Stress

Load case number: 1
Component: VON: von Mises Stress

Stress flag: 1: Node

Layer number: 1
Face flag: 0: Top

Coordinate System: 0
Click Section Plot 

Orientation of section planes: 1:Y

Click Continue

Number of section planes [1,12]: 12

Click Continue and OK to accepts the rest of the defaults

Figure 6-34.  Section Plot of the Von Mises Stress

Visualizing Displacement Results

To generate contour plot for the resultant displacement:

I. Geo Panel: Results > Plot > Displacement/Response/Reaction

Load case number: 1
Component: URES: Resultant Displacement
Coordinate system: 0
Click Continue

Click OK to accept the rest of the defaults
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Figure 6-35.  Resultant Displacement Contour Plot

To animate the displacement plot:

I. Geo Panel: Results > Plot > Animate

Click OK to accept all the defaults.
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